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Say hello to the next generation.

It's found in the world’s most inspirational places. It's pushing the boundaries of art direction
and design. Adobee Creative Suite 2. Today’s most talented designers and art directors are
working smarter and faster because of it. Just ask the masterminds behind INTERspectacular—
they rely on Adobe CS2 to make their ideas tangible reality. See what Adobe Creative Suite 2
can do for you. It's everything but the idea. Better by Adobe.”

adobe.com/go/designer

©2006 Adobe Systems Incorporated. All rights reserved. Adobe, the Adobe logo and Better by Adobe are either registered
trademarks or trademarks of Adobe Systems Incorporated in the United States and/or other countries. Adobe
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$18 Billion Dollar Adobe Moves Center Stage

by Jeremy Geelan

Beyond the Browser

by Kevin Lynch

Web and Mobile Convergence

by Marco Casario

Video Conference with Flex & FMS

by Renaun Erickson

Adding Flash Video to PowerPoint Presentations

by Kim Cavanaugh

Beyond ‘Request-Response’” Modes of Web Services

by Mansour Raad & Andy Gup

Back and Forth

by Rob Rusher

Flex On Ruby on Rails

by Harris Reynolds

Working with Large Applications

‘ by Yakov Fain, Victor Rasputnis, & Anatole Tartakovsky
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ColdFusion Hosting
isourComplete Focus

+ POWERFUL HOSTING PLANS

FREE SQL server access | FREE account setup | Unlimited email accounts Generous disk space & data transfer
30 day money-back guarantee | Great value

- RELIABLE NETWORK

99.99% average uptime | State-of-the-art data center with complete redundancy in power, HVAC, fire suppression,
bandwidth and security | 24/7 network monitoring

"t

# FANTASTIC SUPPORT SERVICES

24/7 suppport services | Knowledgeable phone support | We focus on your individual needs
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866.233.9626 - CFDYNAMICS.COM

For years we have been involved in the Cold Fusion community and have come to know what developers and project managers look for
in a web host. The combination of our powerful hosting plans, reliable network, and fantastic suppport sets us apart from other hosts.
Real service. Real satisfaction. Real value. Real support. Real Freedom.

LIS FRTIIREN VIP. Hosting Partner J/




For answers call us at 1-866-EDGEWEB

When calling your web host for support you want answers, not an
annoying song stuck in your head from spending all day on hold. At
Edgewebhosting.net, we'll answer your call in two rings or less.
There's no annoying on-hold music, no recorded messages or con-
fusing menu merry-go-rounds. And when you call, one of our quali-
fied experts will have the answers you're looking for. Nof that you'll
need to call us often since our self-healing servers virtually eliminate
the potential for problems and automatically resolve most CF, ASP,
.NET, SQL, lIS and Linux problems in 60 seconds or less with no human
interaction.

Sleep soundly, take a vacation, and be confident knowing your
server will be housed in one of the most redundant self-owned data-
centers in the world alongside some of the largest sites on the
Internet today and kept online and operational by one of the most
advanced teams of skilled Gurus, DBAs, Network and Systems Engineers.

For a new kind of easy listening,

WEB HOSTING

talk to EdgeWebHosting.net

EDGE http://edgewebhosting.net

By the Numbers:

.2 Rings or less, live support
- 100 % Guarantee
-99.999¢, Uptime

. 2.6 GBPS Redundant

Internet Fiber Connectivity
- 15 Tier Carrier Neutral Facility
24 x7 Emergency support
« 24 Hour Backup
« Type IV Redundant Datacenter

2003 - 2006

o Shared Hosting o Managed Dedicated Servers o Managed Colocation o Semi-Private Servers
o ColdFusion oBlueDragon oASP o.NET o.Linux o.Java oSQL Server o .MySQL o Self-Healing Servers
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$18 Billion Dollar Adobe
Moves Center Stage

nce upon a time, Sun and Apple

used to have about the same mar-

ket cap. Today Apple has a market

cap of $63BN while Sun’s is just
$17BN. Ahead of Sun, unbeknownst to many,
is Adobe. Its market cap today is $18BN. For
a company that in 1998 was worth “only”
$1.7BN it not been a bad 8 years!

My point is: Everything Changes. And in
the world of Web development and design,
and of the Internet technologies undergird-
ing it all, it changes faster than most every-
where else.

Just 18 months ago no one had
heard of “AJAX" or “Ajax,’ let alone of the
OpenAjax Alliance, ajaxCFC, or LAJAX. No
one had heard of Atlas and no one had
heard of Apollo. Yet right now as you read
this you are fully aware of all these A-words.
Everything changes.

As you read this issue at MAX 2006,
enjoying the late October sun in Las Vegas,
stop and think a moment of how Web
savvy Adobe has become in that same
short 18-month period, and how mobile
savvy it is about to prove itself in the
next 18 months. Think about how much
Google’s role in the i-Technology Landscape
has changed in the same period. Think
about your own career goals, your own skill
set. Has it changed as fast?

It is my firm belief that for developers
and designers alike, from now on, keep-
ing up with Adobe is going to be tough. If
you are not yet familiar with Flash Lite, you
ought to start tomorrow. If you didn't yet
deploy Flash video on your clients’ web-
sites, ditto. If you are not yet experimenting
with the Flash-PDF combo, why not?

With a greater reach than even Microsoft
has, in terms of the number of devices
-- more than 115 million Flash technology-
enabled devices have now shipped world-
wide -- Adobe is very much at what | call the
“i-Technology sweet spot. In this issue the
company'’s Chief Software Architect, Kevin

by Jeremy Geelan

Lynch, unveils how the Apollo runtime will
give developers a new paradigm that dra-
matically changes how applications can be
created, deployed, and experienced.

Whether you are using Dreamweaver
to build HTML or Ajax applications for the
browser, you will be able to take that Web
application to the desktop with Apollo.
While everyone else is wrestling with how
to get Rich Internet Applications working
within the browser, Adobe is already taking
RIAs outside the browser. The possibilities,
once that happens, are virtually limitless.

As Chief Operating Officer Shantanu
Narayen said in a phone interview last
month, “We're seeing an explosion of digi-
tal content and we're poised to capitalize
on that”The next version of the PDF reader,
Adobe Acrobat, is due out in November.
The third edition of Creative Suite, which
packages Photoshop, Illustrator and other
programs (and will be the first to run native
on the new Intel-based Macs), is expected
to ship in the first half of 2007.

The i-Technology stage, in short, is set.
And Adobe is fully kitted out to stride out
right into the very center of it. And stay there.

Don't take my word for it. Take instead
the word of the high-caliber speakers at
MAYX, or of the top-notch writer-develop-
ers in this issue, including Kim Cavanaugh,
Mansour Raad, Rob Rusher, Marco Casario,
Rebaun Erickson, and Harris Reynolds.

Or take the word of Kevin Lynch, leader
of Adobe’s Apollo mission to create a new
cross-0S, cross-device application run-
time to extend the reach of Rich Internet
Applications to the desktop. Because of
Adobe, users will soon get a more compel-
ling experience offline as well as online,
with a rich media application that supports
video, audio, HTML, Flash, and PDF. What’s
not to like?

Everything changes. With Adobe, it
seems always to be for the best. Seize the
day! M\




Meet Robert

A business executive at a popular social media site

Challenges
- Encountering poor video quality due to exponential growth in traffic.
- Increasing bandwidth costs due to growing audience size.

- Experiencing compatibility issues due to user-generated video

arriving in multiple formats.

Solutions

- VitalStream Streaming Services — Improved quality of end-user video

experience using a scalable and global content delivery network.

- VitalStream Advertising Services — Transformed the delivery of

digital media from a cost center into a profit center.

+ VitalStream Transcoding Services — Automatically converted all

user-generated content into the leading streaming media format.

Providing End-to-End Solutions for Your Busine

VitalStream is more than a rich media delivery comp
professional partner providing solutions that meet y:
challenges. To learn more about VitalStream solutions, call 800-

or visit www.vitalstream.com/go/solutions/

QD VitalStream

Digital Media Solutions for Your Business




© 2000 - 2006 VitalStream, Inc. All rights reserved.



Aral Balkan

Aral Balkan is founder and managing director of
Ariaware, a London-based company offering products
like Ariaware Optimizer and the open-source Ariaware
RIA Platform (ARP 2.0) for Flash developers. Ariaware
also offers RIA development process and usability
consulting and development services. Aral holds an
MA in Film and Electronic Media, is a Macromedia
Certified Instructor and is celebrating his 20th year as
a programmer (he's only 27!). His passions include soft-
ware architecture and Human-Computer Interaction
- in other words, building solid, usable applications.
He's co-author of “Flash MX Most Wanted Components”
and “Flash 3D Cheats Most Wanted,” as well as author
and editor of numerous articles for Adobe Developer
Center and Ultrashock.com.

Erik Bianchi

Erik Bianchi is a software engineer with more than
five years of experience developing Flash-based RIAs
and enterprise-wide applications for Fortune 50 and
500 companies. In his spare time he enjoys building
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books, and when burned out on code, playing video
games on his PC/console systems. You can get more
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www.erikbianchi.com.
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Craig Goodman is the managing editor of Adobe’s
Developer Center. He and his team publish the tutori-
als and articles in the area. Craig joined Macromedia
in 1995 and his past roles include managing web sup-
port and supervising product technical support for
Macromedia Flash.

Jim Phelan

Jim Phelan is vice president of development for
Stream57, a New York City based firm specializing in
communication solution development for the enter-
prise. Jim's expertise in creating solutions for consolida-
tion and collateralization of business communications
has allowed his team to create applications for the man-
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content. Jim is a strong proponent of the Adobe Flash
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Andrew Phelps

Andrew M. Phelps is in the Information Technology
Department at the Rochester Institute of Technology in
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Darron J. Schall
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Jeff Tapper, co-founder of Tapper, Nimer and
Associates, has been developing Internet-based appli-
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Beyond
the Browser

he growth of Flash and AJAX in

Web applications is driven by

real market needs - applications

that are visually compelling and
simple to use gain faster adoption and can
be a competitive differentiator, enabling
customers, employees, and partners to
interact effectively with information and
other people. There has been tremendous
innovation in applications delivered via the
Web; however, browser limitations such as
the lack of access to local files, the inability
to leverage desktop functionality, and reli-
ance on continuous connectivity ultimately
limit the functionality of a browser-based
application. In addition, creating these
applications is not always a simple process
and browser compatibility issues continue
to plague front-end developers.

While there are many Web applica-
tions that will continue to thrive in the
browser, the need for better access to
local audio and video assets, and seam-
less integration between desktop and
Web services is driving the next genera-
tion of Rich Internet Applications (RIAs).
The new RIAs will bring added flexibility
and control to developers and engaging
application experiences to users by com-
bining the capabilities of desktop applica-
tions with the reach of the Web.

A New Class of Applications: RIAs on
the Desktop

Adobe is currently working on a proj-
ect code-named Apollo, which is a new
cross-0S, cross-device application run-

time to extend the reach of RIAs to the
desktop. With Apollo, Web developers will
be able to leverage their existing skills

in HTML, XML, JavaScript, AJAX, Flash

or Flex to build RIAs that break free of
browser and platform constraints, allow-
ing them to run on the desktop.

Since Apollo is a cross-platform appli-
cation runtime, it has little or no visible Ul
itself, so developers have complete cre-
ative control over the application experi-
ence they provide to end users. Apollo
eliminates cross-browser testing and the
need for constant page refreshes, ensur-
ing consistent functionality and interac-
tions across desktops. In addition, Apollo
supports seamless online and offline
usage, and rich media plays smoothly
and reliably. The result is a new class of
applications that enhance end-user appli-
cation experiences without the complex-
ity of traditional desktop development.

End users can interact with applica-
tions running on Apollo in the same way
that they interact with native desktop
applications. Users will go through a
familiar install process when placing
Apollo applications on their desktops,
launch the applications the same way
they launch other desktop applications,
and uninstall applications in the same
way they do today. The end result is that
users engage with Apollo applications in
the same way as they do with traditional
desktop applications, but now they will
get a more compelling experience offline
as well as online with a rich media appli-

by Kevin Lynch

cation that supports video, audio, HTML,
Flash, and PDF.

Of course, not all RIAs need to run
outside of a browser on the desktop or
integrate tightly with the OS. There will
be classes of RIAs that work sufficiently
within the browser. Some RIAs may have
elements in the browser and on the
desktop, and it may make sense for other
RIAs to live only outside the browser on
a desktop. Going beyond the browser is
sensible when developers need to:

« Support users in offline as well as
online environments

« Break free of the browser and its
chrome

- Establish a closer relationship with the
user through often-used applications

« Integrate directly with the desktop to
enable capabilities such as drag and
drop, clipboard, system tray icons, and
file extension registration

« Run applications in the background to
bring information to the user

Build Applications Using Familiar
Web Technologies

Apollo is an extension of existing
workflows, and enables developers to work
in familiar environments, leveraging the
skills, tools, and approaches that are most
comfortable. By supporting HTML, XML,
JavaScript, AJAX, Flash, Flex and incorporat-
ing PDF, Apollo allows developers to build
the best possible experience that meets
their needs. Whether using IDEs such as Flex
Builder, which is built on Eclipse, or Web
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design tools such as Flash or Dreamweaver,
or design tools for PDF, developers can
quickly create and deploy applications.

Apollo will provide a set of APIs that
can facilitate different capabilities, such
as system file access, windowing, back-
ground processing, and system tray/toast
notifications. These APIs will be accessible
within JavaScript and ActionScript (both
ECMAScript standard languages) for use
by applications running on Apollo. Their
capabilities are abstracted so that devel-
opers need not worry about the underly-
ing implementation for each operating
system. The Apollo runtime will take care
of integration with the desktop across all
supported operating systems.

By supporting existing Web content
and design patterns, developers can
reuse many of the same assets and code
from their Web-based applications to
build applications that run on the desk-
top. In addition, developers can easily
integrate services, such as Flex Data
Services for data model synchronization
and push and pull notifications, as well as
the Flash Media server for bidirectional
audio/video.

Adobe authoring tools will be opti-
mized for building Apollo applications.

If you are using Dreamweaver to build
HTML or AJAX applications for the
browser, you will be able to take that Web
application to the desktop with Apollo.

If you are currently developing browser-
based RIAs using Flex Builder and the Flex
declarative markup language - MXML

October 2006

- and ActionScript, you can easily extend
your Flex applications to the desktop
with Apollo. In the future, the same will
also be true when using Flash to build
applications using ActionScript. If you
choose a different tool, you'll be able to
leverage the free Apollo SDK, which pro-
vides a command-line utility for packag-
ing Apollo applications.

Apollo gives developers a new
paradigm that dramatically changes how
applications can be created, deployed,
and experienced. Developers gain

Adobe

Kevin Lynch

Chief Software Architect,

more creative control and can extend
their work to the desktop, without
needing to learn complex desktop
development technologies. Given the
tremendous creativity displayed by Web
developers worldwide, the opportunities
for taking RIAs outside the browser are
virtually limitless.

For more information on Apollo and
building Apollo applications, visit http://
www.adobe.com/go/apollowiki. To learn

more about Flex, visit http://www.adobe.

com/products/flex/. A
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Web and Mobile Convergence
Sharing Data Between Flex 2 and Flash Lite

love the definition in Wikipedia of

Media convergence: “Media con-

vergence is a theory in communica-

tions where every mass medium

eventually merges to the point
where they are indistinguishable to each
other due to the advent of new commu-
nication technologies.”

According to the theory of media
convergence, very soon, there will be
no more need to have a television and a
computer separate from each other, since
both would be able to do the job of the
other, ultimately making both extinct and
creating a new medium from the synthe-
sis.’

Even though the prospect of a com-
plete merger among “traditional” media is
still far away, the fact that we have access
to content on multiple devices (internet,
cellular phone, PDA, television) already
enhances the usefulness that such con-
tent provides to users.

Adding to Wikipedia’s definition,
convergence also involves the possibility
of deploying content through differ-
ent channels from a unique source in
a simple, quick, and cost-effective way,
such as the one allowed by the use of
Flex, which | attempt to describe in this
article.

Nowadays, we have all the technolo-
gies that permit developers to create
cross-device applications. By sharing and
accessing the same remote data (via a
database connection, using simple text

file or feeding XML), it's possible to have
interchangeable content and use them
via a mobile phone rather than via a Web
application.

Flex 2 and Flash Lite Together

Soon the next generation of Adobe’s
technology will allow developers to
deploy their Flex (under SWF format)
applications out of the browser, directly
through the desktop.

For those who have never heard
about Apollo, this is the definition given
by Adobe: “Apollo is the code name
for a cross-operating system run-time
being developed by Adobe that allows
developers to leverage their existing Web
development skills (Flash, Flex, HTML,
JavaScript, Ajax) to build and deploy Rich
Internet Applications (RIAs) to the desk-
top” (http://labs.adobe.com/wiki/index.
php/Apollo:developerfaq).

While waiting for this killer applica-
tion, we can now use Flex 2 to create
a rich interactive Web application that
will add and edit remote data. The same
remote data is then served and con-
sumed by a mobile application devel-
oped in Flash Lite. In this article, we'll see
how to create a Flex 2 blog aggregator
where users will be able to add, view, and
save their favorite RSS feeds.

Each blog post can be bookmarked
and stored by users and then viewed
under a Flash Lite application. Let's see
how it works.

by Marco Casario

The Database and the
PHP Remote Services

To start, create the database that
you'll use to store all the blog feeds data
saved by the user. | chose MySq| data-
base, but you can use whatever you like.
| called my db “rssimport”.
Next, create three tables that will hold
the user data. Here is the SQL structure
for our tables:

This table contains a reference to the
news table:
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This table is populated by a Cron service. Cron is the
name of a program that enables UNIX users to execute
commands or scripts (groups of commands) automati-
cally at a specified time/date. It's normally used for
sysadmin commands. In our example, we use a Cron
service to retrieve blog posts from the different blogs
found on “testate” table:

The database is done. We've got our tables, so now
create the PHP scripts that will add blogs to the data-
base, retrieve information over blogs, save posts, and
export all the data in the XML that the Flex application
will consume. The PHP services are pretty simple, but
they're large. You can download all the files here:

This package contains four PHP files. These are the
files called by the Flex’s RPC service. All PHP files return
values in a proper XML format. In fact, data must be
encoded in XML in order to pass them to Flex.

Commenting the PHP file is out of the scope of this
article, but if you develop in PHP, the code should be
self explanatory. If you're not a PHP developer, don't
worry — you'll be able to finish the application and
make all the code work anyhow.

Developing the Flex 2 Blog Aggregator

It's now time to start building the Web interface
that will allow users to add and save their favorite
blogs. Create a new Flex project in Flex Builder 2 (File >
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New > Flex Project) and give it a name. I've called mine
“BlogRoll”

Automatically, some files and folders have been
created by Flex Builder 2. The most important ones are
the bin folder, where Flex Builder puts all the compiled
code and the main MXML application file.

We need to create another folder and name it
“components.” This is the folder where external MXML
Components will be stored. To create a new folder in
the context of the project, go to File > New > Folder.
Our main application is made up of a TabNavigator con-
tainer that houses two states for adding and viewing
blogs. The TabNavigator is a navigation container that
creates and manages the set of tabs used to navigate
among its children. The children of a TabNavigator con-
tainer are other containers.

The container automatically creates a tab for each
of its children and determines the tab text from the
label property of the child, and the tab icon from the
icon property of the child.

When a TabNavigator gets the focus, the Flash
Player processes keystrokes as described in Table 1 (see
the Flex 2 LiveDocs to learn more):

Let’s write some MXML code to create our interface.
Use the BlogRoll.mxml file that Flex Builder has previ-
ously created when you defined your project. Let's
examine in detail the code for the main application file:

We start creating the application tag where we
defined a customized namespace:

This is the package where we'll insert our MXML
components (it points to the folder we previously creat-
ed). Then we call the send() method of the HTTPService
to populate the Datagrid. The method triggers after all
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the user interface elements are loaded on
the creationComplete event, as shown in
Listing 1.

This is where we set up the
HTTPService and call two PHP remote
services: rss.php and add.php. The
former returns all the posts that users
saved. It accepts one parameter defined
inside the <mx:request xmIns=""> tag to
indicate the quantity of posts returned by
the function: 10, 20 or 30 posts. Then on
the result event, it populates the “listAC”
ArrayCollection with data returned by the
response.

The second PHP service - add.php
- receives the name and the URL of the
blog inserted by the user. The two vari-
ables - blog_name and url_blog - are set
to the text attribute of the two Textlnput
with id “frm_name” and “frm_url”. The
HTTPService handles the result and the
fault events. For both services, we use
the POST method to send data, as shown
in Listing 2.

| strongly commented the
Actionscript code, as shown in Listing 3,
so we could go ahead.

We put a <mx:TabNavigator> inside a
panel. The TabNavigator has two children.
On the first Vbox child, we need to create
a simple form that contains the two Text
Input elements: frm_name and frm_url.

At the end of the form, we placed
a Submit button that calls the send()
method of the HTTPService with the
addBlog id. This remote service stores
the name and the URL of the blog added
by the users and puts it into the MySQL
database (see Figure 1).

The second child of the TabNavigator
is made up of a simple Label, a Combo
Box, and an MXML Component. The
ComboBox is populated by the
ArrayCollection “myArray” defined as a
nested tag:

When the user selects an option from
the combo box, the changeHandler()
function is called. The creationComplete
event triggers the init() function and the
the index of the combobox is set up to
the first element.

The MXML Component’s invocation
uses the “cust” namespace defined on
the application tag. The “lista” property is
passed to the component, and it contains
the data returned by the HTTPService
request:

The code of the custBlogData.mxml
file saved in the “components” folder is
shown in Listing 4.The file’s role is to dis-
play the titles and links of all blogs added
by the users. The DataGrid populates
itself with the lista property (data typed
as ArrayCollection) that we get from the
HTTPService. It shows two columns that
display the title and link property con-
tained into the complex lista object:

At the end, a Hbox container sur-
rounds a label and a Button that, if
clicked, calls the send() method of the
HTTPService:

The HTTPService request waits for a
parameter that represents the URL of the
post selected by the user in the datagrid
control. These saved values are stored

into the database and will be requested
by the Flash Lite application. So that all
the news bookmarked will be available
via a Flash Lite enabled mobile phone.

For our purposes, this is enough, but
you could go further in extending the
Flex application.

You should use the StringValidator tag
to validate the data inserted by the user
into the Text Inputs so that you avoid
errors on the business tier. Or, you could
add some styles or customizations to
the user interface using Cascading Style
Sheets (CSS).

The Mobile Application: Creating a
Flash Lite XML Parser

All the data is stored in the MySQL
database. Unfortunately, Flash Lite is
not able to access a database directly.
Therefore, in order to access data, we
need to develop a PHP function that
makes the connection and returns the
values to our Flash Lite interface.

You can try it by launching the URL,
http://88.149.156.198/develop/rssToDb/
rssmobile.php. However, you will see
that another limitation occurs because
the Flash Lite 1.1 player cannot parse
XML directly. It can load dynamic data
via the loadVariables function, using the
name/value pair data structure. Using this
method, you can load almost any data
within Flash Lite 1.1 content.

We were inspired by a ready-to-use
PHP RSS parser written by Alessandro
Pace who explained in an article for
Adobe Developer Center (www.adobe.
com/devnet/devices/articles/flash-
litell_rss.html) how to create a Flash Lite
1.1 RSS (Really Simple Syndication) reader
using a server-side PHP RSS parser.

With the following PHP 5 XML parser,
a RSS 2.0 feed will be read to extract the
<title> and <description> tags contents
for each <item> block, and then the
content will be customized so it can be
loaded into the Flash Lite 1.1 RSS reader
on the mobile phone, as shown in Listing
5.

The values returned by the echo will
produce the following output:
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The code is pretty simple and well
commented but if you want further
explanation, you can read the “Analyze
the Code” section of the tutorial (http://
www.adobe.com/devnet/devices/articles/
flashlite11_rss_02.html).

It's now the turn of the Flash Lite user
interface. You can download the com-
plete application on the Adobe Devnet :
Flashlite11_rss_samples.zip (http://down-
load.macromedia.com/pub/developer/
flashlite11_rss_samples.zip). Opening
the Flash file, you'll see the application
is made up of 5 frames and 3 layers. The
most important part of code is contained
in frame two, where the call to the server
is made using the loadVariable function:

The “http” variable points to the
server-side PHP file’s URL, and it’s definied
on frame one:

The loadVariable function reads data
from an external file, such as a text file
or text generated by server-side script
(Coldfusion, PHP ...), and sets the values
for variables in a target movie clip. The
text at the specified URL must be in the
standard MIME format application/x-
www-form-urlencoded (a standard for-
mat used by CGI scripts):

All the navigation features are hidden
on frame five inside the hidden button
used to select the variables title and
description and to scroll the dynamic text
contained in the description variable, as
shown in Listing 6.

Conclusion
The game is over. Thanks to the Flash

Platform, in just a few simple steps, we
built a simple Flex 2 application that
manages data with PHP from a MySQL
database. Data is then exposed and
presented through a mobile applica-
tion that uses Flash Lite as development
technology. Users can reach through their
cellular phones blog posts they previ-
ously selected and stored via a Flex 2 Web
application.

The source code for this article can be
downloaded from the online version of
this article at webddj.sys-con.com. A

Listing 1
<mx:HTTPService

id="hs”

url=” http://88.149.156.198/devel-
op/rssToDb/rss.php “

useProxy="false”

result = “listAC = hs.lastResult.

rss.channel.item as ArrayCollection” >

<mx:request xmlns=””">
<qty>{myCombo.value}</qty>
</mx:request>

</mx:HTTPService>

<mx:HTTPService id=”"addBlog”

url="http://88.149.156.198/devel-
op/rssToDb/add.php”

useProxy="false”

method="POST”

result="blogAddedHandler(event)”

fault="faultHandler(event)”>

<mx:request xmlns=””>

<blog_name>{frm_name.text}</blog_
name>

<url_blog>{frm_url.text}</url_blog>

</mx:request>

</mx:HTTPService>

Listing 2
<mx:Script>
<! [CDATA[
import mx.collections.
ArrayCollection;
import mx.rpc.events.

ResultEvent;

// This is the
ArrayCollection variable that store
the

/! values returned by

HTTPService’s request

[Bindable]

private var listAC:ArrayCollection;

// The init function is called by
the combobox element.

// It adds at the first item of
the ArrayCollection named

// myArray the value of 10

private function init():void
{
myArray.addItemAt({label:”10
posts”, data:”10”}, 0)

// This function is called when
the user selects
// an item from the combo box.

// It simply calls the send()
method of the HTTPService

// with an id “hs”

private function changeHandler():
void
{

hs.send();

// The event handler of the
HTTPService’s result event

// It makes

// the text input empty. Then it
calls again the

// send() method of the
HTTPService

private function
blogAddedHandler(event:ResultEvent):
void

{

frm_name.text = “”;
frm_url.text = “7;

hs.send();
mx.controls.Alert.show (“Blog

added”, “HTTPService’s Result Event”)

// The event handler of the
HTTPService’s fault event

// This is a function to handle
potential errors that

// occur during a HTTPService
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request

private function
faultHandler(event:mx.rpc.events.
FaultEvent):void
{
var faultInfo:String="fault
description: “+event.fault.faultDe-
tail+”\n\n”;
faultInfo+="fault faultstring:
“+event.fault.faultString+”\n\n”;
mx.controls.Alert.

show(faultInfo,”Fault Information”);

1=

</mx:Script>

Listing 3

<mx:WipeLeft id="WL”/>

<mx:Panel title="Flex 2 Blog

Aggregator” >

<mx:Image source="http://www.com-

taste.com/images/logo.gif” />

<mx:Text text="Insert the blog you
want to add to your preferite list.”

height="28"/>

<mx:TabNavigator width="350"
height="350">
<mx:VBox label=”"Add Blog”
width="100%" height="100%"
showEffect="WL">
<mx:Form width="100%">
<mx:FormHeading label="Insert a
new blog”/>
<mx:FormItem label="Name”>
<mx:TextInput id=”frm_name” />
</mx:FormItem>
<mx:FormItem label="URL’s
address”>
<mx:TextInput id=”"frm_url” />
</mx:FormItem>
<mx:HBox>
<mx:Spacer width=”50” />
<mx:Button label=”"Add” id="btn_
add” click="addBlog.send()” />

</mx:HBox>

</mx:Form>
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</mx:VBox>

<mx:VBox label="View Blogs”
width="90%" height="100%"
showEffect="WL">

<mx:Label text="Show the latest :”
id="myLbl” fontWeight="bold”/>

<mx:ComboBox id="myCombo”
change="changeHandler()” creationCompl
ete="init();myCombo.selectedIndex=0" >
<mx:ArrayCollection id="myArray”>
<mx:0Object label=”20
posts” data="20"/>
<mx:0Object label="30
posts” data="30"/>
</mx:ArrayCollection>

</mx:ComboBox>

<cust:custBlogData width="100%"
lista="{hs.lastResult.rss.channel.

item}” />

</mx:VBox>

</mx:TabNavigator>

<mx:ControlBar>

<mx:Label text="Developed by Marco
Casario” />
<mx:LinkButton label="http://casario.
blogs.com” click="navigateToURL (new
URLRequest ( ‘http://casario.blogs.

com’),’_blank’);”/>
</mx:ControlBar>
</mx:Panel>

</mx:Application>

Listing 4
<?xml version=”1.0" encoding="utf-8"?>
<mx:VBox xmlns:mx="http://www.adobe.

com/2006/mxm1”>

<mx:HTTPService
id="saveHS”
url="http://88.149.156.198/devel-
op/rssToDb/savenews.php”
useProxy="false”
method="POST”
result="1inkHandler(event)”

fault=”"faultHandler(event)”>

<mx:request xmlns="”>

<url>{myDG.selectedItem.link}</
url>

</mx:request>

</mx:HTTPService>

<mx:Script>
<! [CDATA[

import mx.collections.

ArrayCollection;

import mx.rpc.events.ResultEvent;

[Bindable]
public var lista:ArrayCollection;
[Bindable]

private var counter:Number

private function linkHandler(event:
ResultEvent) :void
{

counter = event.result.list.
total;

counterLbl.text = “Post saved so
far : “ + counter;

mx.controls.Alert.show (“Post has
been stored”, “HTTPService’s Result

Event”);

}
private function
faultHandler(event:mx.rpc.events.
FaultEvent):void
{
var faultInfo:String="fault
description: “+event.fault.faultDe-
tail+”\n\n”;
faultInfo+="fault faultstring:
“+event.fault.faultString+”\n\n”;
mx.controls.Alert.

show(faultInfo,”Fault Information”);

1=

</mx:Script>

<mx:Style>
DataGrid {

depthColors: #EAEAEA, #FF22CC,
#FFFFFF;

alternatingItemColors: white,
gray;
}

</mx:Style>




<mx:DataGrid id="myDG” $title);
dataProvider="{lista}” width="100%" > $description = str_
<mx:columns> replace(“&”, “”, $description);
<mx:DataGridColumn
headerText="Posts” dataField="title” // Return the content with the appro-
width="150" /> priate index
<mx:DataGridColumn echo “&title$i=".$title;

headerText="Link” dataField=”1ink” /> echo “&description$i=".$desc

“While waiting
for this killer
application, we
can now

use Flex 2

to create arich
interactive Web
application that
will add and edit
remote data”

ription;
</mx:columns> //echo $ij;
</mx:DataGrid> $it+;
} else {

<mx :HBox>

<mx:Label text="Add this news to
your bookmark : “ />

<mx:Button label=”Save”
click="saveHS.send();” />

</mx:HBox>

<mx:Label id="counterLbl” />

</mx:VBox>

Listing 5

//Link to RSS 2.0 feed
$link_to_rss_feed
="http://88.149.156.198/develop/rss-
ToDb/rssmobile.php”;

//Counter to append to &variables to
return to the client

$i=1;

// This PHP 5 function loads the
entire XML feed
$xml = simplexml_load_file($link_to_

rss_feed);
// Parse each item in the RSS feed

foreach ($xml->channel[0]->item as
$item)
{
if ($item) {
// Need to strip html tags
since Flash Lite does not support
// html in dynamic text
fields
$title = strip_tags($item-
>title);
$description = strip_

tags($item->description);

// Replace special symbols &

$title = str_replace(“&”, “”,

// Send and Error message if
content is not found

echo “&msg=Content not

found”;
echo “&flag=error”;
echo “&end=end”;
exit;
}
}
$i=%i-1;

echo “&flag=ok”;
echo “&totalitems=”.8$i;

echo “&end=end”;

Listing 6
// Shifting variables
on (keyPress “<Right>”) {
if (n ne totalitems) {
n++;
} else {
n=1;
}
title = eval(“title” add n);
description = eval(“description”

add n);
}

on (keyPress “<Left>”) {
if (n ne 1) {
n- -;
} else {
n = totalitems;
}
title = eval(“title” add n);
description = eval(“description”
add n);
}
//Scrolling
on (keyPress “<Up>”) {
description.scroll--;
}
on (keyPress “<Down>”) {

description.scroll++;
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Video Conference
with Flex & FMS

by Renaun Erickson

ideo over the Internet
and Rich Internet

Applications (RIA) are the

latest craze. With Flex 2

and Flash Media Server 2
(FMS), developers can easily
create interactive media Web

applications. In this article
you'll create a basic video con-
ference application that will give
you the foundation to take you to
the next step.
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Flash Media Server 2 software has
been in the wild since November 2005. In
the last year, the use of media on the Web
- especially video - has taken off. From
streaming video to real-time multi-user
interactive applications, FMS is the tool to
use. For example, chat, video, and audio
conferencing, as well as whiteboard
sharing applications can be built upon
the FMS technology. The user clients are
typically built with the Flash IDE, but
this article will show you how to put it
all together with Flex 2 and FMS. Flex 2
has made it much easier to create high,
impactful RIAs. With each new wave of
technology, features are built, and inter-
connectivity standards have to be explic-
itly stated. You will learn about a subtle
change in the Flash Player 9 that Flex 2
uses. The subtle change will need to be
addressed to create our video conference
application in Flex and FMS.

The Flash Player 9 introduced a
newer Action Message Format version
called AMF3. Flex 2 creates ActionScript
3.0 SWF’s, but Flash Media Server is
still based on ActionScript 2.0 and the
earlier AMFO. By default, the Flex 2
NetConnection class uses AMF3, there-
fore you must tell the NetConnection
what object encoding to use. There are
two ways to do this:

or

The first method changes the object
encoding for the instantiated object only,
whereas the second method changes the
object encoding for all NetConnections
globally. With the NetConnection set to
use AMFOQ, the Flex application will know
how to communicate with the FMS appli-
cation properly.

Another common pitfall has to do with
understanding when to connect Flex com-
ponents to the FMS application. You need
to wait for the NetConnection to return a
status of NetConnection.Connect.Success
before connecting any Flex component

to the FMS server-side component. This is
done by adding a status event listener on
the NetConnection with a function that
will consume the response and check on

connection success.

Now it’s time to create the FMS back
end. | assume that you understand the
basic layout and application structure
of the FMS server. You can visit the FMS
documentation to gain a basic tutorial
on how to install, configure, and deploy
FMS applications. For this article, you will
want to create a flex_videoconference
folder under the applications folder in the
default install of FMS. The default FMS
installation folder on a Windows machine
is C:\Program Files\Macromedia\Flash
Media Server 2\applications; for Linux,
it's /opt/macromedia/fms/applications.
FMS uses service-side ActionScript (ASC)
files. The ASC files are used to create the
server-side component and FMS applica-
tions. All service-side applications require
a main.asc file. For the example video
conference application, you will need to
create main.asc and add the following
ActionScript code (see Listing 1 for full
source). The application startup code
will initialize and retrieve a shared object
users_so that contains the list of users.

When a client connects to the applica-
tion, the server will accept the connec-

tion, and the user will be added to the
users_so shared object.

The last part of the main.asc file con-
tains the code to handle client disconnec-
tions and remove them from the users_so
shared object.

| want to point out that this applica-
tion implementation of handling the
list of current users as a single remote
shared object will not allow different
simultaneous video conferences. This can
be achieved a couple of different ways
which are out of the scope of this article,
mainly through the use of FMS applica-
tion instances or more sophisticated FMS
server-side application implementation.

With the back end FMS application
ready to go, the next step is to create the
Flex client. The basic layout of the sample
application uses a ViewStack with two
children Ul controls, a form to log in, and
a video conference viewing control.

A simple form with a text box for the
name of the user and a submit button
that calls createConnection will do just
fine. In the full source listing, you will find
added code to disable the login form if
the user does not have a camera available
(see Listing 2).
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After the submit button is clicked
and the createConnection method is
called, the Video panel that contains all
the current video conference users will
be displayed upon a successful connec-
tion. To do this, a connection to the FMS
server is made. As defined in the main.
asc, the Flex client needs to send a name
and identifier to the server-side appli-
cation when connecting to the server
application.

The identifier algorithm used is not
terribly important, but the code above
goes through and swaps all the space
characters with underscores. These iden-
tifiers are used to publish and play the
streaming video. One of the features of
FMS server technology is the ability to
record the published video on the FMS
server. The FMS server uses the published
name to create the name of the record
FLV file, and depending on the underly-
ing OS, you might want to pay attention
to the identifier value.

The NetConnection object con-
nects to FMS through a protocol called
Real-Time Messaging Protocol (RTMP).
The NetConnection’s connect method
requires URL parameters. All other
parameters after the URL parameters
are sent to the server as arguments to
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the connect method call. The URL value
“rtmp:/flex_videoconference/” tells the
NC to connect to the server running the
script’s flex_videoconference applica-
tion. You can learn more about RTMP
and FMS connection URLs in the FMS live
documentation. The server-side applica-
tion creates a SharedObject by the name
of users_so. The shared object stores the
list of users connecting to the application,
and provides a list of all connected users
to each specific client.

Remember that the connecting of
components to the server needs to be
done after the NetConnection has suc-
cessfully connected. You can now add
the connectComponents and the code to
switch to video conference view into the
netStatusHandler function.

In connectComponents a client-side
SharedObject object is created and con-
nected. Flex is asynchronous, and you
will need to set an event to listen for any
changes to the remote shared object.

The sync event handler will monitor
the remote users_so and retrieve the
latest value if anything changes. After
receiving a sync event message, the func-
tion turns the remote object into an array
of users. The array of users then gets cre-
ated into our dgUsers’s ArrayCollection.

The dgUsers is used as the data provider
in video conference view control.

The video conference view is now
ready to be created. The video confer-
ence view consists of a panel, tile, and
repeater control. The repeater, with
dgUsers as the data provider, will cre-
ate a custom VideoPod control for each
user. Although the video component is
custom, the guts are quite simple. You
will find the full source of the VideoPod in
Listing 3. The idea is to first check if the
user is a sender or receiver. Ifit's a sender,
you attach the camera and microphone
to the Net Stream object and publish it to
the server.

When the custom VideoPod is to
display the receiving video feeds, the
component creates a stream and calls the
play method.

The video class in Flex 2 is used
to display video streams. A simple




VideoContainer class is found in Listing 4 and is used
in the VideoPod component to make it easier to add
any video object as a UlComponent. This is needed
because the video class is not a UlComponent, so it
can't be added as a child to the panel class directly.
The VideoPod now is ready to be put into the video
conference view control using the repeater inside a
tile control.

Now, you can put it all together, compile it,
and try it out for yourself. The application’s struc-
ture consists of the main mxml application called
FlexVideoMain.mxml (see Listing 2), VideoPod.mxml
(see Listing 3), and VideoContainer.as (see Listing
4). Complementing the client application the FMS
server application requires main.asc (see Listing 1)
to be placed in flex_videoconference folder in the
applications area. The application provides a simple
one room multi-user video conference solution. Of
course, the maximum number of users possible in
each video conference will depend on bandwidth.
There are other considerations in creating live,
media-rich applications like latency, quality of the
video, and frame rates (which affects perceived
latency). A

Listing 1
application.onAppStart = function()

{

trace(“Begin sharing text”);

/] Get the server shared object ‘users_so’
application.users_so = SharedObject.get(“users_
so”, false);

}

application.onConnect = function(client, name,
identifier)
{

client.identifier = identifier;

application.users_so.setProperty(identifier,
name) ;
application.acceptConnection(client);

}

application.onDisconnect = function(client)
{
trace(“disconnect: “ + client.identifier);

application.users_so.setProperty(client.identi-

fier, null);
}
Listing 2

<?xml version=”1.0” encoding="utf-8"?>
<mx:Application xmlns:mx="http://www.adobe.
com/2006/mxml1”
xmlns="*”
initialize="haveCamera = ( Camera.getCamera()
!= null )”
layout="vertical”>
<mx:Script>

<! [CDATA[

import mx.collections.ArrayCollection;

import mx.controls.Alert;

[Bindable]

private var haveCamera:Boolean;

[Bindable]

public var nc:NetConnection;

public var users_so:SharedObject;
[Bindable]

public var dpUsers:ArrayCollection;

public function createConnection():void
{
if( txtName.text.length > 0 ) {
nc = new NetConnection();
nc.objectEncoding = ObjectEncoding.AMFO;
nc.addEventListener( NetStatusEvent.NET_
STATUS, netStatusHandler );

var identifier:String = txtName.text;
while( identifier.search( “ “ ) > 0 )

identifier = identifier.replace( “ “,

nc.connect( “rtmp:/flex_videoconfer-
ence/”, txtName.text, identifier );
} else {
Alert.show( “Please provide a name for
the video chat connection!” );

}

public function netStatusHandler( event:

NetStatusEvent ):void
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“Another
common pitfall
has to do with
understanding
when to

connect Flex
components to the
FMS application”

switch( event.info.code ) {
case “NetConnection.Connect.
Success”:
connectComponents();
vsMain.selectedChild =
pnlvVideo;

break;

public function connectCompo-
nents():void
{
SharedObject.defaultObjectEncod-
ing = flash.net.ObjectEncoding.AMFO;
users_so = SharedObject.
getRemote(“users_so”, nc.uri, false)
users_so.addEventListener
SyncEvent.SYNC, usersSyncHandler );

users_so.connect( nc );

public function usersSyncHandler (
event:SyncEvent ):void
{
var results:Object = event.tar-
get.data;
var usersArray:Array = new
Array();
for( var a:String in results ) {
var obj:0bject = new Object();
obj.name = results|[ a ];
obj.identifier = a;
usersArray.push( obj );
}
dpUsers = new ArrayCollection(
usersArray );

}

public function logout():void
{
users_so.close();
nc.close();
dpUsers = null;
users_so = null;
nc = null;

vsMain.selectedChild = pnlLogin;

11

</mx:Script>

<mx:ViewStack
id="vsMain”
width="100%" height="100%">
<!-- Login Panel -->
<mx:Panel id=”pnlLogin”>
<mx:Form>
<mx:FormItem label=”Name:”>
<mx:TextInput
id="txtName”
enabled="{ haveCamera }” />
</mx:FormItem>
<mx:Button label=”Submit”
click="createConnection()”
enabled="{ haveCamera }” />
<mx:Label text="{ ( haveCamera )
? ‘’:’Now camera is found!’ }” />
</mx:Form>
</mx:Panel>
<!-- Video Panel -->
<mx:Panel id="pnlVideo”
width="100%" height="100%"
title="Welcome { txtName.text }!”

layout="vertical”>

<mx:Tile height="100%"
width="100%">
<mx:Repeater id=”"rpUsers”
dataProvider="{ dpUsers }”>
<VideoPod
nc="{ nc }”
isSender=”"{ rpUsers.curren-
tItem.name == txtName.text }”
userItem="{ rpUsers.curren-
tItem }” />
</mx:Repeater>
</mx:Tile>
<mx:ControlBar>
<mx:Button label="Logout”

click="1logout()”/>

</mx:ControlBar>

</mx:Panel>
</mx:ViewStack>
</mx:Application>

Listing 3

<?xml version=”1.0” encoding="utf-8"?>
<mx:Panel xmlns:mx="http://www.adobe.
com/2006/mxm1”

xmlns="*”

title="{ userItem.name } Pod”

creationComplete="init()”
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layout="vertical” width=7200"
height=7220">
<mx:Script>

<! [CDATA[

import flash.media.Video;

private var microphone:Microphone;
private var camera:Camera;

private var video:Video;

[Bindable]
public var userItem:Object;
public var nc:NetConnection;

private var ns:NetStream;

[Bindable]

public var isSender:Boolean;

private function init():void

{

ns = new NetStream( nc );

video = new Video( 180, 180

if( isSender ) {
camera = Camera.getCamera();
/ /Number (objConfig.quality)
camera.setQuality( 16384, 0 );
camera.setMode( 180, 180, 15,
false );
// Set loopback as compressed

camera.setLoopback( true );

video.attachCamera( camera );

ns.attachCamera( camera );

microphone = Microphone.getMi-
crophone();

ns.attachAudio( microphone );

ns.publish( userItem.identifier

} else {

video.attachNetStream( ns

ns.play( userItem.identi-
fier );
}

videoDisplay.video = video;

}
11>
</mx:Script>
<VideoContainer
id="videoDisplay”

width="180" height="180" />
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</mx:Panel>

Listing 4

package

{

import mx.core.UIComponent;
import flash.events.Event;

import flash.media.Video;

public class VideoContainer extends
UIComponent
{

private var _video:Video;

public function VideoContainer()
{
super();
addEventListener(Event.RESIZE,

resizeHandler);

public function set
video(video:Video):void
{
if (_video != null)

{

removeChild(_video);

_video = video;

if (_video != null)
{
_video.width = width;
_video.height =
height;
addChild(_video);

private function

resizeHandler(event:Event):void

{
if (_video != null)
{
_video.width = width;
_video.height =
height;
}
I
i
}




Adding Flash Video to
PowerPoint Presentations

owerPoint has been capable

of accepting and playing back

videos for quite some time, at

least as far back as Office 97.

In most cases the process is
quite simple. Go to the Insert menu, click
on Insert Movies, and away you go. At
least in theory.

The reality of the situation is that
your success with video in PowerPoint
may vary wildly. Sometimes things will
play back absolutely perfectly, especially
if you use the same computer with the
same operating system to create and
encode the video, create the PowerPoint
file, and play back the slide show. When
a single machine is used, your results are
generally pretty good, although there
may be times when the audio and video
lose their synchronization. For the most
part, as long as you stick with a single
machine, video in PowerPoint works just
fine.

But what happens when you develop
your video and PowerPoint show on
different machines? Perhaps you're col-
laborating with someone else who is
producing the video while you create the
slide show. It’s possible that they may use
a video codec that is incompatible with
your machine, such as when a newer ver-
sion of QuickTime is used for the video,
but an older version of PowerPoint is the
only one you have available. Or perhaps
your presentation looks great on your
computer, but when you attempt to take
the show on the road and use a different

machine, you find that your video fails

to play back correctly. Maybe you need
to share your completed presentation
with a co-worker so they can also use the
PowerPoint for presentations. In many

of those types of situations, video in
PowerPoint can be problematic.

Luckily, there is a solution that works
between versions of PowerPoint that
eliminates the unknowns and ensures
that your video will play back exactly the
way you want. By converting your video
to Flash Video and inserting the com-
pleted file into your PowerPoint show,
you can be certain that the video will
play back regardless of the computer and
even the operating system that is being
used.

In this tutorial you will learn:

» How to set up your project for the best
results

» Options for encoding the video for
playback

+ How to insert Flash files into
PowerPoint

Preparing Your Project

When you are working with a project
such as this, there is a very simple and
time-honored principle to keep in mind
- K.IS.S. or Keep It Simple, Stupid. (At
least that's what | was taught the acro-
nym meant.)

When you are working with mul-
tiple files, it is almost always best to
work entirely within one folder. Your
PowerPoint file as well as the Flash video

by Kim Cavanaugh

and Flash files you need for playback

should all be saved into a single folder.

There are several advantages to this

method:

« By keeping your files in one location,
the task of writing the path to the
Flash files is greatly simplified. As you'll
see, you need to know the path and
file name to the Flash file if you want
your movie to play back correctly. With
all of the files in one location, you elim-
inate the issue of having to remember
how to write the path. Instead, you'll
only need to write the file name when
the time comes to insert your Flash
movie into PowerPoint.

+ Moving the project to another com-
puter or to removable media becomes
much simpler when all the files are in
one location. If you need to show your
presentation at a location other than
your workplace, you can simply copy
the entire folder onto a flash drive or
CD and take the show with you. Or, if
you need to share the presentation
with someone else, you can zip the
file up and send it to them by e-mail.
Either way, having all your files in one
location makes them much more por-
table and easy to work with.

- If you are using Flash 8 and the video
components for producing your video
playback movie, you'll need to move
the playback SWF that is created along
with the movie that holds your video.
Once again, having all these files in
a single folder greatly simplifies this
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process and eliminates errors when
playing back your file.

Cross-Platform Compatibility

Sadly, the latest Macintosh version
of PowerPoint does not play well with
Flash files that contain videos in the FLV
format as of this writing. However, Flash
Video is still a great way to incorporate
your QuickTime files that may not play
properly in the Windows environment.
You can do your editing in iMovie
and share the files at the size of your
choosing, convert the files to FLV, then
incorporate them easily for playback in
Windows. For video files that need to
play on a Macintosh computer your best
bet will be to stay with the QuickTime
format and insert the movies directly
into your presentation.

Options for FLV Conversion

If you have Flash 8 Professional, you
already own the best tool for converting
video to the FLV format. Using the Flash
Video Encoder that ships with Flash 8
Pro you can convert your video easily,
then use the excellent FLV Playback
component to build your SWF file for
insertion into PowerPoint. This is the
most full-featured option as you can
choose from the different playback con-
trollers that ship with Flash 8 Pro to add
a sweet little controller that will allow
you to start, stop, and rewind your video
directly from within PowerPoint.

If you don't own Flash 8 Pro, you'll
need another method for convert-
ing your videos to the FLV format. My
personal recommendation is Sorensen
Squeeze (http://www.sorensonmedia.
com/solutions/prod/comp_win.php),
which allows you to create either an FLV
file for use in building a Flash project,
or, for even faster conversion, you can
create the complete SWF directly in
Squeeze with the FLV file embedded in
the completed file. The only drawback
to this method is that there will be no
controller available when the video
plays within your PowerPoint presenta-
tion. You will still be able to use simple
controls for playing the video, but you
will need to do that by right-clicking
on the video and choosing the options
presented in the context menu that
appears.
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Preparing Your Video in Flash 8
Professional

For the sake of the remainder of this
tutorial, let's assume that you will be
using Flash 8 Professional to prepare your
video files for playback and that you have
already converted your movie into the
FLV format. For more on creating video
playback files in Flash 8, see Tom Green's
Creating a Video Player in Flash Professional
8 (http://www.communitymx.com/abstract.
cfm?cid=12EBE) .

There are a few things to keep in mind
when creating your movie file in Flash if you
plan to incorporate them into a PowerPoint
presentation.

First, when choosing the playback
controller you should select one of the
“Over” style skins rather than an external
controller. While the controller will work just
fine inside the presentation, the difficulty
comes when you need to scale the movie
to the proper size. PowerPoint can pres-
ent a challenge when it comes to scaling
your movie to the correct size as it seems
to have a mind of its own for creating and
maintaining an aspect to the resized movie.
In practical terms, this can lead to a gray
box appearing around the movie when you
attempt to resize the SWF file. Just as both-
ersome, the controller itself can be cut off

when the movie is resized as well, leading
to lots of wasted time when you want to
get the movie object sized to one that gives
the best quality during playback. The best
method to avoid this is to simply put the
controller on top of the video.
Second, the computer that you will be
presenting on must have Flash Player 8
installed in order for the video to play back
correctly. This is not a big problem in most
cases. If you simply go to the Flash player
download page (http://www.macromedia.
com/shockwave/download/download.
cgi?P1_Prod_Version=ShockwaveFlash)
using Internet Explorer, the latest version of
the Flash Player will be downloaded to the
machine in, well, a flash. Just be certain that
you allow yourself sufficient time if your
presentation will be given away from your
normal workplace to check for Flash Player
8 and install the player if needed.
With all of that said, the actual creation
of a video playback file in Flash 8 couldn’t
be easier. Let’s run briefly through the steps.
1. Create a new Flash document. Save the
file in the same folder as your PowerPoint
presentation.

2. Open the Components panel by choos-
ing Window > Components.

3. Open the FLV Playback - Player 8
folder in the Components panel and
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11. Click Modify > Document.
12. Click on the Match Contents radio
button to have Flash automatically size
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drag an instance of the FLVPlayback
component onto the stage.

. Name the component MyPlayer in
the Properties inspector.

. Click on the Parameters tab in the
Properties inspector.

. Click on the Browse button in the
contentPath category of the param-
eters listing as you see in Figure 1.

. In the Content Path dialog box,
enter the name of your FLV file.

You can also click the Browse but-
ton to browse to your file location.
(Remember that it is recommended
that the FLV file be located in the
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same folder as the PowerPoint file for
ease of use.)

8. Be sure to check the Match source
FLV dimensions checkbox as you see
in Figure 2.

9. Click on the Browse button in the
Skin category of the parameters list-
ing as you see in Figure 3.

10. Use the dropdown menu in the
Select Skin dialog box to choose one
of the available playback controller
skins. Remember that due to the
particular way that PowerPoint sizes
and resizes Flash movies, one of the
“Over” styles is recommended.
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13. Click File > Publish. Your movie is now
ready to insert into your PowerPoint
presentation.

Inserting a Flash File into PowerPoint
Now that your Flash movie is ready,
it's time to insert the Flash file into your

PowerPoint presentation. This involves

a toolbar that most people don't use

very often, if at all, but other than turn-

ing that toolbar on, there isn't anything
in this process that is difficult. Let's see
how it's done.

1. Save your PowerPoint presentation in
the same folder where your Flash files
are located.

2. Go to the slide where you want the
video to appear.

3. Click on View > Toolbars > Control
Toolbox.

4. Click on the More controls button that
you see circled in Figure 4.

5. From the menu that appears, select
Flash Shockwave Object as you see in
Figure 5.

6. Your cursor will now change to a
crosshair symbol. Drag our rectangle
onto the slide that is approximately
the size of your Flash movie. You'll
resize the object once the movie is
loaded.

7. Right-click the white box that repre-
sents your Flash object on the slide
and select Properties from the context
menu. The Properties dialog box will
open.

8. Click on the button next to the
Custom field at the top of the dialog
box as you see in Figure 6.

9. In the dialog box that appears, you
will insert the name of the SWF file
that contains your movie. Once again,
this is another place where the wis-
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dom of keeping all the files in one
location is seen as there is no Browse
button or automatic method of set-
ting the path to the file. In order to
insert the Flash movie file, simply
place the name of the SWF file that
you published from Flash in the Movie
URL field as you see in Figure 7.

10. Click OK.

11. Test your slide show by choosing
Slide Show > View Show. Your movie
will load and play when the slide
opens. When you end the show you
will see the last frame where the video
stopped inside the PowerPoint slide.

12.It’s likely that you'll need to resize the
Flash object on the stage to get the
best quality from your video. You can
do that by clicking once on the Flash
object on the slide and using the
resize handles to change the size of
your video as you see in Figure 8. Your
presentation with a slick little video
included is now ready to go.

One thing to keep in mind is that
PowerPoint will remember the movie's
position every time you play your slide-
show. To ensure the video plays from the
beginning, be sure to rewind and save
your file before you make that big pre-
sentation.

Conclusion

As you have seen here, inserting
Flash files containing Flash video is fairly
easy, and definitely worth the effort if
you want to ensure consistent playback
of your video, no matter where you
show it. By inserting a Flash movie with
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an embedded video file inside, you

can be certain that whether you need
to move the presentation onto a Flash
drive or CD to show at another loca-
tion, your movie will open with its audio
intact and play back perfectly. Not only
that, but you'll also have the nice con-
trols that are available in Flash 8 just in
case the people watching your show are
so impressed that they want to see your
video over and over again. A

Welcome to the Palm Beaches!

“Inserting Flash
files containing
Flash video is
fairly easy,

and definitely worth
the effort if you
want to ensure
consistent playback
of your video”




Beyond ‘Request-Response’
Modes of Web Services

eographic Information Systems

(GIS) services today are going

mainstream. Corporate execu-

tives and individuals at home

are demanding access to many
of the same GIS capabilities previously
used only by engineers, geologists, and
government officials.

ESRI's ArcWeb Services are at the fore-
front of expanding demand for interac-
tive GIS applications. Using subscription-
based Web mapping APIs, developers can
integrate mapping, GIS functionality, and
content into applications delivered online
or on desktops, handheld computers, and
other devices. Every day, ArcWeb Services
serves more than 6 million mapping
requests, helping companies manage
commercial fleets, analyze demographic
data to spot trends, map locations, and
execute other requests.

As the reach of GIS expands, new
approaches are needed to develop Web
services that are more intuitive, interac-
tive, and visually engaging. Typically,
ArcWeb Services developers program
in variety of programming languages
including Java, .NET, and PHP to build
request-response infrastructures for pre-
senting increasingly complex data sets
that mix archived information with real-
time data feeds from ArcWeb Services.
The applications generally wait for some
input from the end user, and, once a
request is completed, the application
waits for the next input.

To address new demands for GIS

capabilities, the ArcWeb Services team
took a closer look at Adobe’s Macromedia
Flash and then evaluated Adobe Flex.
Flex addressed several needs. First, it lets
ArcWeb Services deliver dynamic content
as SWF files, providing flexibility in the
type and richness of geographic informa-
tion available to customers. This content
is delivered through ArcWeb Services
Explorer, which is currently based on Flex
1.5 and will be migrated to Flex 2 in the
next release.

With ArcWeb Services Explorer,
developers can now build Rich Internet
Applications (RIAs) that provide geo-
graphic functionality and content in a
desktop-like environment. The capabili-
ties are encapsulated within the ArcWeb
Services JavaScript API, which allows
developers to embed ArcWeb Services
Explorer into a Web application with just
a few lines of code.

In addition, Flex provides the ability
for applications to take advantage of
vector graphics, which are mathematical
representations of images that contain
points, lines, curves, and polygons. Vector
maps are vector graphics that contain
information related to individual geo-
graphic features within the map image,
such as roads, lakes, national parks, over-
passes, and elevation data. The applica-
tions can now interact with the individual
features. For example, features can be
highlighted or turned on and off, objects
can be dynamically moved around, and
even sound and movies can be embed-

by Mansour Raad & Andy Gup

ded. The vector mapping capabilities are
made possible by Flex, and they are the
key to providing ArcWeb Services cus-
tomers with desktop-like functionality.

In comparison, traditional raster map
images, such as bitmaps (.bmp) and GIFs,
are static and are designed to provide
only a description of the colors within
the image. Raster images were designed
to be rendered, rather than to contain or
enable functionality, and are the format
of choice for delivering mapping applica-
tions that require visual precision, as in
satellite imagery.

With vector-based mapping function-
ality, ArcWeb Services developers can
now rapidly build and deploy Flash-based
client applications that directly interact
with individual features, as well as mul-
tiple layers of data. For example, a street
map can be used as the base layer and a
zip code boundary shape file can be over-
laid on top of that. Then, demographic
information can be overlaid as different
colored, semi-transparent shadings. This
application can be built using just the
ArcWeb Services JavaScript API.

The rich Internet mapping applica-
tions our customers are developing today
have dramatically changed how people
access and interact with content. For
instance, ArcWeb Services can be used
to enhance a real-estate Web site. Rather
than limiting users to searching by zip
codes or street addresses, clients can
draw their own boundaries on screen.
The real-estate application then automat-
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ically searches for properties that meet
their criteria - price, size, specific features
- within their drawn boundaries. Search
results are presented as rich content,
including video and interactive maps.
Other clients are finding new ways
to engage with once-static online maps.
Mapping services that simply showed
people how to get from point A to point
B are being replaced by more dynamic
services that combine directions and
images with real-time traffic and weather
information. For instance, if the direc-
tions drivers received an hour ago are
no longer optimal because of changing

traffic conditions, the interactive system
automatically pushes out new informa-
tion, alerting drivers that route changes
are needed.

A primary reason ESRI can deliver
these enhanced services is that Flex gives
ArcWeb Services more control on both
the server and client sides. The ArcWeb
Services Flash client provides a rich
component library that doesn’t require
developers to spend a lot of time creating
trees, tables, and canvases. With Flex, we
have skinning, piling, and the ability to
easily integrate other SWF components
into ArcWeb Services’ client interfaces.

ArcWeb Services customers can now
develop rich applications in hours that
previously could have taken weeks to
develop.

Based on our development experi-
ence and new client expectations, it is
clear that the nature of Web services
is changing. For many of ESRI's cus-
tomers, simply receiving and viewing
content is not enough. Instead, end
users want real-time access to dynamic
mapping content, trusting that the
data and services they require will

be available even before they ask for
them. Ja\
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Back
and Forth

or over a decade now, we have

been trained to use the “back”

and “forward” buttons in our

Web browser to review or back-
track previously viewed content. We are
trained to the point that there are even
keyboard shortcuts. Unfortunately, this
can be a problem when browsing Flex
applications. Being the well-trained
users that we are, we often forget that
we could cause the Flex application to
reload unwittingly.

Fortunately, there is a solution that
is built into the Flex SDK and HTML
templates that are generated in a Flex
Builder project. By default, Flex enables
history management for only a couple of
navigator containers, without using any
additional ActionScript or MXML tags.
Although this is a good start, we often
need more options to build truly custom
applications.

In order to implement your own cus-
tom history management, you will need
to use the HistoryManager class that is
part of the Flex 2 SDK. By implementing
the API, you can create custom history
management for your custom objects in
an application. Note: History manage-
ment is not supported on Netscape 4.x
and Opera 6.0 web browsers.

History Enabled Components

History management is avail-
able by default for the Accordion and
TabNavigator navigator containers. It is
disabled by default for the ViewStack

navigator container. When history man-
agement is enabled, as the user navigates
different navigator containers within

an application, each navigation state is
saved. Selecting the Web browser’s “back”
or “forward” browser button displays the
previous or next navigation state that was
saved. History management keeps track
of where you are in an application, but

it is not an undo and redo feature that
remembers what you have done. Note:
When history management is enabled

for a particular component, such as a
navigator container, only the state of the
navigator container is saved. The state

of any of the navigator container’s child
components is not saved unless history
management is specifically enabled for
that component.

Custom History Management

The mx.managers.HistoryManager
package is pretty useful for building
generic undo mechanisms. It must
be imported before using it. The
HistoryManager provides a register ()
method that allows you to register
any object with it, even if it does not
have a visual element. To register a
component with the HistoryManager
class, that component must imple-
ment the |HistoryManagerClient
interface, and then it must be regis-
tered with the HistoryManager class.
You will then pass along a reference
to a component instance to manage.
Each registered component receives a

by Rob Rusher

unique state ID based on its full path-
name.

In the following example, the
Application component (this) is regis-
tered with the HistoryManager class
when the Application is initialized:

By implementing the
IHistoryManagerClient interface, you
“agree” to implement the following two
methods into your object’s code:

- function saveState() : Object
- function loadState( state : Object) :
void

The HistoryManager calls the saveState ()
method on all registered objects every
time the state of the application changes.
It's up to you to return any object that
describes the current state of your object
(like a snapshot). If this state is going to
be restored, then all registered objects
receive their state back via the loadState ()
method. Again, it’s up to you to rebuild
the state by investigating the snapshot.
You can also inform the
HistoryManager to save the current
state of the whole application by calling
its static save() method. This has to be
done by hand if a performed action has
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to result in building a “snapshot” of your
application. I've illustrated (see Listings
1 and 2) two ways to implement the
HistoryManager:

How the HistoryManager Class
Saves and Loads State

The history management feature uses the
Macromedia Flash navigateToURL() function
to load an invisible HTML frame in the cur-
rent Web browser window. It then encodes
a Flex application’s navigation states into the
invisible frame’s URL query parameters (using
the standard prop1=value1&prop2=value2
format). A SWF file, called history.swf, in the
invisible frame decodes the query parameters
and sends the navigation state back to the
HistoryManager class. You can investigate this
by viewing the HTML source that is generated
along with a Flex application.

Condlusion

Once again, the Flex SDK has made it pos-
sible for extending components to be history
management enabled very easy. By simply
implementing an interface and utilizing the
HistoryManager class, you are able to quickly
avoid many Pavlovian nightmares from the
back button. Keep in mind that this feature
should be used primarily for managing navi-
gation and not for undo/redo. Although you
could accomplish some level of undo/redo
if you are creative, there are definitely better
ways of doing it, so it's best to stick to naviga-
tion with the HistoryManager. | hope you
found these examples easy to follow and
helpful in your learning process. A
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Listing 1

HistoryWindow.mxml
<?xml version=”1.0” encoding="utf-8"?>
<mx:TitleWindow xmlns:mx="http://www.
adobe.com/2006/mxm1”
implements="mx.managers.
IHistoryManagerClient”
creationComplete="initPanel()”
move="doMove()”
mouseUp="doMouseUp()”
width="200" height="150"
backgroundColor="#FFFFFF”
cornerRadius="8"

horizontalAlign="center”>

<mx:Script>
<! [CDATA[
import mx.effects.Move;
import mx.managers.HistoryManager;

private var changed Boolean;

public function initPanel() : void

X = 0;
y = 0;
HistoryManager.register( this );

storelnternalState();

public function saveState()
Object
{
// called by HistoryManager,
tells the component
/| to create a “state” object

and to return it

return { xPos:x, yPos:y };

public function loadState( state

Object ) : void
{

// called by HistoryManager,
passes in a state

/] object so the component can
rebuild it’s state

if( state != null )

{

restoreInternalState( state );

private function doMove() : void

changed = true;

private function doMouseUp()
void
{
if ( changed ) storeInternal-
State();
}

private function storeInternal-
State() : void
{
HistoryManager.save() ;

changed = false;

private function restoreInternal-

State( state Object ) : void




“Once
again, the
Flex SDK

has made it
possible for
extending
components
to be history
management
enabled

very easy”

var mover Move = new Move( this );
mover.xTo = state.xPos;
mover.yTo = state.yPos;

mover.play();

1=

</mx:Script>

<mx:Text text="Just move me around, use the
browser’s buttons to restore state.”
selectable="false”

width="100%"

fontSize="12"/>

</mx:TitleWindow>

Main.mxml

<?xml version="1.0” encoding="utf-8”?>
<mx:Application xmlns:mx="http://www.adobe.
com/2006/mxm1”

initialize="initApp()”>

<mx:Script>
<! [CDATA[

import mx.managers.PopUpManager;
public function initApp() : void

PopUpManager.createPopUp( this,
HistoryPanel, false );
PopUpManager.createPopUp( this,
HistoryPanel, false );
}
11>

</mx:Script>
</mx:Application>

Listing 2
StockQuote.mxml
<?xml version="1.0” encoding="utf-8”?7>
<mx:Application xmlns:mx="http://www.adobe.
com/2006/mxm1”
implements="mx.managers.
IHistoryManagerClient”
initialize="mx.managers.HistoryManager.

register( this );”>

<mx:Script>
<! [CDATA[

import mx.managers.HistoryManager;

public function saveState() : Object
{
var state : Object = new Object()
state.symbol = symbol.text;
return state;
}
public function loadState( state
Object ) : void
{
if (state != null && state.symbol !=
null ){
symbol.text = state.symbol;

ws.getQuote.send();

}
public function getQuote() : void
{
ws.getQuote.send();
HistoryManager.save();
}
11>

</mx:Script>

<mx:WebService id="ws”
wsdl="http://services.xmethods.net/soap/
urn:xmethods-delayed-quotes.wsdl”
useProxy="false”>
<mx:operation name="getQuote”>
<mx:request>
<symbol>{ symbol.text }</symbol>
</mx:request>
</mx:operation>

</mx:WebService>

<mx:Label text="Enter a symbol:”/>

<mx :HBox>
<mx:TextInput id=”"symbol” width="60"/>
<mx:Button label="Get Quote”
click="getQuote()”/>

</mx :HBox>

<mx:Label text="{ ws.getQuote.lastResult }”
fontSize="24"
fontWeight="bold” />
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Flex On
Ruby on Rails

ith the release of Flex 2,
Adobe has introduced a
tool that makes building
rich user interfaces for
the Web easier than ever; of course, as
anyone remotely plugged in to the Web
development community knows, Ruby
on Rails has made creating database-
driven Web applications brain dead sim-
ple. This article discusses a technology
that marries Flex with RoR applications
by providing a means of automating the
communication between the client and
server. The technology is “WebORB for
Rails," a free and open source (GPL) serv-
er made available by Midnight Coders
(www.themidnightcoders.com).

Many of the tutorials on the Web
that talk about integrating Flex clients
with Rails discuss using raw XML over
HTTP. While this mechanism is nice for
the standard “mom and apple pie” tuto-
rial that return a simple list of records,
this level of integration quickly becomes
unwieldy as the complexity of the appli-
cation grows. With each new operation
on the server, a developer must spend
valuable cycles serializing and deserial-
izing requests and responses before they
can focus on the actual business logic.

WebORB relieves the burden of this
“serialization tax” by supporting the
concept of remote objects whereby Flex
clients can natively invoke methods on
the server and retrieve the responses all
within ActionScript, the object-oriented
programming language used by Flex.

This article will discuss installing
WebORB to “Flex-enable” a Ruby on Rails
application, the steps required to cre-
ate an application using Flex + WebORB
+ RoR, and some advanced topics like
dealing with Rails models, etc.

Installing WebORB for Rails

WebORB runs as a plug-in for Rails
and is installed by simply running the fol-
lowing command within the root directo-
ry of a Rails application. On *nix systems:

or on Windows:

Writing an Application Using WebORB
There are three simple steps that are

required to build a Flex-based RIA utiliz-

ing WebORB and Rails.

1. Build the service class and drop into
RAILS_APP/app/services

2. Add an entry to RAILS_APP/config/
WEB-INF/flex/remoting-config.xml for
the remote service

3. Set up a RemoteObject on the client-
side using Flex that will communicate
directly with the back-end service.

As a simple example consider the fol-
lowing service written in Ruby:

by Harris Reynolds

This example is bundled within the
WebORB on Rails product and simply
returns a bag of properties related to the
server running the service. Generally,
the classes that are surfaced as remote
objects are added to a /services direc-
tory under the RAILS_APP/app directory.

After creating this class, you must
also tell Flex that this class needs to be
available as a remote object. This is con-
figured by adding the following snippet
of XML to the remoting-config.xml file
located within the RAILS_APP/config/
WEB-INF/flex directory:
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Last, this service is invoked by a client
by using the RemoteObject class within
ActionScript. Below is a small chunk of
code that demonstrates how to use this
class:

Assuming that the remote object
variable was declared at the top of your
MXML application, this code illustrates
creating and initializing a remote object
for use. Note in particular that the des-
tination property is set to “InfoService”,
which maps directly to the ID attribute
of the destination we just configured
within remoting-config.xml. Note that
this is how Flex (and WebORB) deter-
mines where to send this request. The
final two lines above demonstrate add-
ing callback methods to the remote
object; the first line tells Flex to pass
the result of a call to the getComput-
erinfo method (this maps to the Rails
service method on the server) to the
onResult method (which is on the cli-
ent). The last line tells the remoteOb-
ject instance to pass any faults to the
onFault method (also implemented
in ActionScript). The example below
shows the two event listeners that were

registered above:
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Now the remote object can invoke
the method on the server written in
Ruby by simply calling:

and the results will be available in the
event.result object that is passed to

the onResult method as demonstrated
above. In this example each property
that is stored on the server is available
as a property of the event.result object
that we store above in the computerinfo
instance. The source code for this exam-
ple is available as part of the WebORB
distribution for those interested in look-
ing at the complete picture; after install-
ing WebORB the server code is available
in /app/services/InfoService.rb and the
client code is available in /public/exam-
ples/example.mxml.

Advanced Features of WebORB
Active Record Integration

The previous example is a simple
tutorial on how integrating Flex and
Rails works using WebORB and the
RemoteObject class. However, when
building Rails applications, most of the
interesting data for your application will
be available via the ActiveRecord API
in the data model layer. This is actually
where WebORB provides a great deal of
value: it natively serializes Rails model
objects to Flex clients including han-

dling any associations that are requested

as part of an active record query.

Consider the following Ruby class that
can be dropped into a ProductService.rb
file within /app/services:

This service will return all the prod-
ucts in the database and include associ-
ated image records; this type of service
would be great for displaying a product
list within a DataGrid that also could
display product images upon selecting
a row in the grid. On the client side the
results of this method invocation could
be made available in an ActionScript
method such as:

Also note that within each prod-
uct, another array is available that is
accessed through the images property
(the Image model in rails would likely
include a URL or path attribute that Flex
could use to load pictures). As an exam-
ple, the following ActionScript method
could be attached to the “change” event
of the DataGrid:




“Another
useful feature
of WebORB
is the ability
to access

the HTTP
request or
session objects
within remote
Rails services”

Last, remember that if you do not
want to include associated data (has_
many/belongs_to relationships within
Rails models), then simply do not pass
the :include option to your query.

Access to the HTTP Request
and Session

As a final note, another useful fea-
ture of WebORB is the ability to access
the HTTP request or session objects
within remote Rails services. These
objects are available to standard Rails
controllers that operate at the HTTP
level; however, when using WebORB,
developers simply develop “services”
that are server methods that gener-
ally act as a layer between clients and
Active Record models without inherent
knowledge of the HTTP transport proto-
col. There will be times, however, when
a service will need access to either the
HTTP request or session. This is made
available through a RequestContext
class that can be included in any
remote service. This technique was
actually used in our first example. Note
the “require ‘weborb/context” line
within InfoService.rb listed above; this
line imports the RequestContext class
so that developers can access the HTTP
request and session via the respec-
tive RequestContext.get_request and
RequestContext.get_session class-level
methods. Any data that is stored in the
session will be available to subsequent
requests using the standards Rails ses-
sion API after retrieving the session
object similar to:

Basic Authentication Support
WebORB provides support for basic
authentication of client applications.
This allows credentials to be set on the
RemoteObject instance, and services

to access the associated user name
and password on the server. On the cli-
ent side this is done with ActionScript
using the setCredentials method on a
RemoteObject instance.

This information is available using
the same RequestContext API discussed
above. Within your service you can get
the credentials using the APl demon-
strated below:

The one problem with this approach
is that now the service code is contami-
nated with authentication code. Ideally
this would happen before ever reach-
ing the method (like using a “before
filter” in Rails controllers. WebORB will
eventually provide an interface that
will authenticate users in a similar way
before ever reaching secure methods.
In the meantime, it is important to
make this feature available for devel-
opers who need this capability today
(WebORB on Rails will continue to
support this APl even after a cleaner
approach is provided).

Conclusion

This article provided an initial
glimpse into how Flex clients can be
integrated with Ruby on Rails using
WebORB’s Flex RPC implementation
and the RemoteObject API. While some
applications with very simple data
requirements can happily integrate Flex
and Rails using model.to_xml and stan-
dard HTTP requests, WebORB on Rails
simplifies the development process as
the amount of client/server interaction
scales to a large number of request/
response types. A
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Working with
Large Applications

n this excerpt from our book, Rich
Internet Applications, we'll cover
how to set up large applications
intended for Web or, more broadly
speaking, distributed deployment. As
an example let’s consider an enterprise
application that consists of hundreds of
screens, reports, forms, and dashboards.
Accordingly, about a dozen engineers
specializing in GUIs, frameworks, data lay-
ers, and business domains are working on
this application in parallel.

Every application “run”in Flex Builder
as well as the invocation of the applica-
tion’s MXML file processed by the Web-
tier Flex compiler requires an application
build. Needless to say, this takes time. The
bigger the application, the more time it
takes.

Developers need a fast process of
building and deploying their applications.
The application also has to be par-

titioned for team development both
vertically (application screens) and hori-
zontally (Ul, skins, reusable components,
and back-end code). Imagine working
on two “portlets,” one of them showing
a DataGrid and the other a TreeView.
You have a choice: either package a TMB
module with both portlets or download
separate ones (500K each) on demand.
The latter way has the additional benefit
of isolating the work between the team
members.

Finally, the model should allow the
extensibility of the product, meaning the
integration of patches and portlet-style

add-ons as well as external Flex subsys-
tems shouldn’t impact the main build.

We'll try to accommodate these
requirements emphasizing the productiv-
ity of team development and deployment
flexibility. But first let’s review the deploy-
ment scenarios from the business point-
of-view in detail.

Deployment Scenarios

Throughout this excerpt we'll use
the term patches, which are the fixes
and additions made to an application
between releases. Add-ons are the parts
of the application that are typically added
over time. Similar to patches add-ons
blend seamlessly into the hosting appli-
cation, both visually and programmati-
cally.

In some cases the application build
may not even “know” about specific add-
ons since they're different for each user
type. For example, an enterprise applica-
tion can reveal more screens or more
functionality within these screens to
internal users. In this case we talk about
portlet-style add-ons.

Plug-ins are independent applications
that don't share the look-and-feel of the
main application. No intensive interaction
between the main application and plug-
ins is expected.

Application Domains 101

As much as we don't like to duplicate
the work done by the Adobe Flex docu-
mentation team, we have to cover the

by Yakov Fain, Victor Rasputnis,
& Anatole Tartakovsky

subject of Application Domains since it's
essential to this chapter. So, here are the
facts.

All code loaded from an SWF file lands
in one or another application domain.
Conversely, instances of the flash.system.
ApplicationDomain class stores the tables
of the ActionScript 3.0 definitions and
class definitions in particular.

A system domain contains all the
application domains and there’s a cur-
rent domain where the main application
runs. There’s also a parent domain for
each domain except the system one.
System domains, quite naturally, happen
to be the parent of the main application’s
domain.

The definition of the loaded classes as
long as they remain loaded can’t be over-
riden down the parental chain. Attempts
to reload a class that’s already been
loaded by its parent will fail. If you're
coming from the Java side, you may have
seen a similar mechanism called Java
ClassLoader.

We also have to mention the security
domains of the Flash Player, since parti-
tioning the classes (visibility) via applica-
tion domains is within the confines of the
security domains. The choice of a security
domain is relevant for use cases when
we need to load an SWF file coming from
a different server, which is outside the
scope of this chapter.

So, an application domain is the
mechanism that (a) supports multiple
definitions of the same class where chil-
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dren can access parent definitions seam-
lessly or (b) lets child definitions be ten-
tatively merged with parent ones so that
accessing the other party’s definitions is
seamless for both the child and the par-
ent.

This mechanism is enacted by
flash.display.Loader and mx.controls.
SWFLoader controls.

The first choice is represented by the
syntax new ApplicationDomain(Appli
cationDomain.currentDomain) while the
second one is ApplicationDomain.cur-
rentDomain.

A specific sub-case of (a) is the use
of a system domain as a parent: new
ApplicationDomain(null), which results in
the ultimate separation of the (class) defi-
nitions, eliminating any overshadowing.

Either way, the required application
domain is getting assigned the applica-
tionDomain property of a Flash.system.
LoaderContext instance, which, in turn is
used as an argument to construct a flash.
system.Loader, or acts as a property of an
mx.controls.SWFLoader.

There are nuiances in accessing child
definitions from the parent as well as in
loading/accessing possibly overshadow-
ing the class definitions.

When you bring existing Flex subsys-
tems (perhaps even written in a different
version of Flex) under a common applica-
tion umbrella, it makes sense to resort
to a separate application domain. At the
same time, if you need to dynamically
load DataGrid definitions, it makes sense
to load them in the same application
domain where the main application is
running.

Runtime Shared Libraries 101

Flex documentation defines Runtime
Shared Libraries (RSL) as “a library of
components.” We would like to start with
the clarification that RSL is not a file but a
pattern of using an SWF file from within
another SWF file.

Specifically, SWFs marked as RSLs
are automatically pre-loaded during
the application’s bootstrap as opposed
to being explicitly loaded by the code
you write. To be exact, definitions
contained in the SWF are loaded into
the applicationDomain of the hosting
application.
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Now how does the application’s bootstrap
know which SWF files are to be pre-loaded?
Here is an answer. Let’s assume that:

a) You made the file FlexLibrary.SWC
(using the compc compiler explicitly or
from within the Flex Builder’s Library
Project);

b) You've created the file FlexApplication.
mxml, which refers to components
from FlexLibrary.SWC;

¢) While compiling FlexApplication.
mxml you instructed the mxmlc com-
piler that FlexLibrary.SWC contains
an image of an SWF to be pre-loaded
during the bootstrap (this will be
explained later in this chapter).

Then, the corresponding ActionScript
file generated by the mxmlc compiler will
have the code fragment shown below.
You'll find this and other files in the gen-
erated folder of your application project
once you set the compiler’s option to
keep-generated-actionscript=true:

As a reminder, the SystemManager
is a parent of all the displayable
objects within the application, such
as the main window (an instance of
mx.core.Application), pop-ups, cursors,
etc. SystemManager also creates the

mx.preloaders.Preloader that loads SWF
files.

Please note that FlexLibrary.swf is not
an RSL. As we said above, RSL is a usage
pattern rather than a file. What makes
FlexLibrary.swf part of this pattern is the
intent to pre-load it during the applica-
tion startup communicated by us to the
mxmlc compiler.

This illustrates that the RSL approach
results in class definitions from the library
are loaded into the same domain where
the definition of the application classes
belong. That’s why, in particular, we find
the RSL technique especially useful for
delivering various patches, which should
be loaded prior to any other class defini-
tions.

SWFs and SWCs: What's

Under the Hood

How do our SWC files relate to SWFs?
Like every Flex SWC, FlexLibrary.SWC
contains the library.swf and catalog.xml
files. The latter describes the hierarchy of
dependencies found in library.swf, which
can potentially become FlexLibrary.swf
(depending on the selected link type
described below).

When we compile FlexApplication.
mxml containing references to
FlexLibrary.SWC in the library search path,
there are three link types to choose from:
- External - The catalog.xml in the

FlexLibrary.swc will be used to resolve
references; however the code con-
tained in library.swf won't be included
in the body of the FlexApplication.swf.
The External link type assumes that

by the time FlexApplication needs to
create instances of classes from the
library.swf part the definitions for these
classes will somehow get loaded in the
relevant applicationDomain.

+ RSL -The catalog.xml in the
FlexLibrary.swc will be used to resolve
references; code contained in library.
swf won't be included in the body
of the FlexApplication.swf. So far
sounds like External, right? Here's the
difference: all definitions originally
contained in the library.swf part will be




upfront-loaded into the main applicationDo-
main during application startup.

+ Merge-in - Classes that are explicitly refer-
enced by the code (and their dependencies)
explicitly get included in the FlexApplication.
swf. This is a default option for statically
linked applications and guarantees that the
definitions of all referenced classes as well as
the classes they depend on are loaded into
the main applicationDomain outright.

A Merge-in scenario is often called static
linking, while External and RSL are cases of
dynamic linking.

Suppose we went with dynamic linking via
RSL. As illustrated in the previous code frag-
ment, this means pre-loading the FlexLibrary.
swf. Here’s the question: where do we get this
FlexLibrary.swf from? Under one scenario we can
let Flex Builder extract and rename the library.
swf from the FlexLibrary.swc. In Flex Builder
(project Properties >Flex Build Path> Library
Path) this option is called Auto extract swf.

Alternatively, we could have declined auto-
extracting and unzipped the SWF from the SWC
ourselves. As we'll show later, there's yet another
way of explicitly controlling the upfront build of
FlexLibrary.swf.

We'll illustrate these cases in the next sec-
tion.

Making the FlexLibrary.swc

Let’s make an SWC in Flex Builder by creat-
ing a new Flex Library Project. The only com-
ponent we're going to add to this SWC is the
CustomPanel from the following code which
enumerates the instances of itself and imprints
the number of the instance as part of its title,
using the variable instanceNumber that we've
declared bindable:

To ensure that our CustomPanel is accounted
for (in both library.swf and catalog.xml) we have
to verify that it's included in the Flex Library

Build Path. Please be aware that every time you
add or rename files in your Library Project the
corresponding checkbox in Flex Builder gets
cleared.

After we click OK, Flex Builder will invoke the
compc compiler to create the FlexLibrary.swc in
the output bin folder.

Making a FlexApplication Application

Now let’s make the application in a separate
Flex Builder project. Nothing fancy, we'll just
make a static reference to the CustomPanel:

Link our library, compile, and run the appli-
cation.

To resolve the reference during compile
time we had to add our recently created library
FlexLibrary.swc to the project’s Library Build
Path. The default link type is to merge-in the
SWC'’s content.

Merging the contents of SWC results in an
optimized, non-overlapping size of the mono-
lithic application. The size of such a self-suffi-
cient FlexApplication.swf is 123KB.

Now let’s alter the setting and turn static
linking dynamic and setting the Link type to
RSL. We'll accept the (default) value of Auto
extract.

As a result of the Auto extract the file
FlexLibrary.swf will appear adjacent to the
FlexApplication.swf. The size of the FlexLibrary.
swf will be 236K, nearly as much as the
entire FlexLibrary.swc, but the size of the
FlexApplication.swf itself will decrease to 40K.

As you can see, Flex attempts static linking
of RSL content (Merged into code) by default.
This ensures that the smallest size of the result-
ing monolithic SWF, because it carries only the
code that was deemed relevant during the com-
pilation process.

Naturally, the total of 236K + 40K takes two
times longer to download then downloading
of the statically linked 123K. However, once you
have a family of three applications to offer the
same user, all approximately the same size and
all reusing the same FlexLibrary.swf, it becomes
(236 + 3*40) versus 3*123 and you break even.

The download considerations are less rel-
evant on the fast connections and, perhaps, are
not relevant at all in scenarios where you can

count on the browser cache to keep SWF files
loaded for the next run of the application. A typ-
ical example of the latter would be a corporate
environment, but then again, some administra-
tors set policies to wipe out the browser’s cache
on user logoff.

Static versus Dynamic Linking:
Development Perspective

While the time of the initial download is an
important factor in favor of static linking, we
have to consider development productivity as
well.

Let’s look at enterprise applications. Driven
by user requirements, they tend to change fre-
quently. Many enterprise applications tend to be
on the larger side, growing in functionality and,
accordingly, size, with phased delivery to the
users. As an application gets to tens of mega-
bytes, the time required to build the monolithic
application becomes a noticeable setback to
developer productivity. The problem escalates
in a team development where it translates into
many hours wasted every day.

And, regardless of size, let’s look at the use
case of portlet-style add-ons. These are modules
that are simply impossible to reference statically
in advance. In fact, they are not even supposed
to be pre-loaded at all: unlike RSLs they get
loaded on demand.

All'in all, we need to be able break the appli-
cation into a set of modules that can be built
independently and linked dynamically at run-
time.

So, You Say Dynamic Linking?

By now the reader may say, “OK, | got the
message, I'll go with RSLs to modularize my
development with dynamic linking.” Not so fast.
Like ancient Achilles, these mighty RSLs have a
small weak spot: their well-being depends on
static linkage from the main application.

Oh, but doesn't that ruin the hope of dynam-
ic linking? The answer is no, and the explanation
is just around the corner in the next section.

First, however, let's create an applica-
tion to expose the problem. We'll build a
FlexApplication2.mxml application. Unlike our
previous example, it won't contain static refer-
ences to CustomPanel. Instead, FlexApplication2
will create instances of a CustomPanel (or any
other object for that matter) dynamically, given
a name of the class definition as it’s done in the
function createComponent():
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If you run the application and click the
“Create Panel” button, the code terminates
abnormally.

The reason for this error is that many times
mxmlc complements classes with additional
initialization code at the SystemManager level.
But if the relevant classes are completely shield-
ed from mxmlc it's absolved from taking care
of them. Let’s explain this in detail. Please have
another look at the generated SystemManager
of the FlexApplication that we had in the previ-
ous example:

Advertising Index

Advertiser URL Phone

If we compare this SystemManager with
the one generated for FlexApplication2 we’'ll
see that in the latter case the mixins array is
short of the three values: “_ControlBarStyle,’
“_PanelStyle,”and “_CustomPanelWatcherSet
upUtil.
The classes referenced in the mix-
ins array take part in the initialization
sequence of the application upon the
initial load. In particular, CustomPanelWa
tcherSetupUtil is the class that facilitates
the binding for the vari-

Page able instanceNumber of
CustomPanel. In the case of
FlexApplication2, this part
of the initialization “gets
forgotten.”

Now that you have seen
the differences between the
applications manifested in
_<ApplicationName>_mx_
managers_SystemManager
files, you're likely to notice
the others, such as files
<ApplicationName>_FlexInit.
as. For example, in Chapter
8 we annotated the

EmployeeDTO class with the metadata keyword
RemoteClass:

In the case of SimpleAutoCompleteWithD
ynamicDataDemo, this metadata annotation
results in the following:

And again, the registration snippet

wouldn’t have materialized if the compiler
didn't know about the EmployeeDTO.

All in all, MXML files as well as metadata-
annotated ActionScript classes might not get
the expected initialization support if you put
them in RSL and don't explicitly reference them
in the calling application.

Conclusion

The second part of this article will discuss
dynamic linking, self-initialized libraries, RSL
vs. custom loading of the dynamic libraries,
embedded applications and SWFLoader, and
optimization of application size.

To order a copy of Rich Internet Applications
with Adobe Flex & Java, please go to www.
riabook.com. [a\
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Other companies in this magazine spent a lot of time on pretty ads. As
you can see, we did not. We spent our time hiring the best people and
training them to deliver outstanding support for your website. We
spent our time building a state of the art datacenter and staffing it with
people who care about your website like it's their own. Compassion,
respect, credibility, ownership, reliability, “never say no,” and exceed
expectations are words that describe our service philosophy. From the
first time you interact with us, you'll see what a difference it really

makes. And you'll also forgive us for not having a pretty ad.
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